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Removing an Existing Driver
Use the following procedure to remove an existing Windows NT driver. If updating (not reconfiguring) this 
driver, make sure that you remove the existing driver before installing the updated driver.

1. Open the Control Panel and start the Network applet.

2. If using Windows NT 4.0 , select the Adapters tab. 
If using Windows NT 3.51 , skip to the next step.

Note:  All screens shown in this section are taken from 
Windows NT 4.0. If you are using Windows NT 3.51 
or Citrix WinFrame, note that the screens look 
different but have similar functions. Adapt the 
instructions as needed.

3. Highlight Comtrol RocketPort,RocketModem.

Warning: If Comtrol RocketPort,RocketModem does not 
appear in the Adapters window, click the Cancel 
button right now, then go to the Special 
Instructions on Page 3.

4. Click the Remove button. You are asked to verify the 
deletion.

5. Click Yes. The selected item is deleted.

6. Click Close. Several windows are displayed as the system 
updates its configuration:

7. Click Yes to shut down and restart the server, so that your changes take effect.

8. After removing the existing driver, use the  Installing a New Driver discussion.

Note: This procedure does not remove the Comtrol RocketPort RocketModem program group. If you wish to do 
so, see the “Start Menu” topic in the Windows NT help system for more information.

Special Instructions
If Comtrol RocketPort,RocketModem  does not appear in the Network Adapters window, click Cancel to exit 
from the Network applet. Then start the Comtrol RocketPort/RocketModem Setup program, set the droplist 
for each board to Not Installed, and save and reboot.

This should remove the driver and clean up all associated files. If it does not resolve the situation, contact 
Comtrol Technical Support for more assistance.
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Installing the New Driver
Use the following instructions to install the RocketPort/RocketModem Windows NT driver. If using Citrix 
WinFrame, follow the instructions for Windows NT 3.51.

Note: If updating the Windows NT driver, remove the existing driver first. Do not use the Update option.

These procedures assume that you have already installed the hardware and determined that it is working 
properly. For information about the bootable diagnostic, see the media shipped with your product or the ftp/
web site.

Driver Installation
After you have extracted the driver files (if needed), follow these steps:

1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhood icon and 
select Properties.

2. If Windows NT 4.0 , select the Adapters tab.

If Windows NT 3.51 , click the Add Adapter button.
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3. Windows NT 4.0 only : Click the Add button. The list of supported network adapters displays: 

4. If Windows NT 4.0 , click the Have Disk button.

If Windows NT 3.51 , scroll down to the bottom of the list, highlight the Other option, and click the Continue 
button. 

5. If installing the driver from a diskette, insert the diskette.

Note: Make sure that you have extracted the files from the Comtrol media or any downloaded file from the 
ftp/web sites.

6. Enter the drive and directory path to the installation files and click the OK button.

For example, if you used the self-extractor utility to create a c:\comtrol directory, enter: 

c:\comtrol

7. Click the OK button with Comtrol RocketPort/RocketModem highlighted.
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8. Click Next when the Add Device Wizard 
appears and follow the on-screen 
instructions to configure the adapter type 
you installed in your system. You must 
install and configure at least one adapter 
at this time. If you are installing more 
than one adapter, install all PCI-bus 
adapters before installing any ISA-bus 
adapters.

Depending on the model of adapter you 
have installed, enter the following 
information.

Note: The prompts that display and the 
options associated with each 
prompt change depending on your 
selections. If you reach a point 
where the available options do not 
match your product, you probably 
selected an incorrect choice on an earlier page. In this case, use the Back button to backtrack and 
review your selections, and correct as needed.

a. Bus Type. Select ISA or PCI and click Next.
b. Model. Use the droplist to select the Comtrol product you have installed, and click Next.
c. Number of Ports. Use the droplist to select the number of ports on the product you have installed, 

and click Next.
d. Base I/O Address. (ISA-bus products only .) Use the droplist to select the I/O address you set using 

the DIP switches on the adapter. (See the Hardware Installation Card .)

If you are installing a PCI adapter and this prompt appears, you selected the wrong Bus Type in Step 
a. Click the Back to go back and change your selection.

e. Country. (Comtrol modem products only .) Use the droplist to select the country or region where the 
modem will be used.
Note: Not all Comtrol modem products support all country selections. Check your packaging to make 

sure that your modem supports the country you wish to select.
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9. When you have finished entering adapter configuration information, click the Finish button. The 
appropriate Device Setup window displays:   

10. Review the information shown. If desired, you can enter a more descriptive name for the adapter, change 
the base I/O address setting (ISA-bus only), or change the COM number assigned to the first port on the 
adapter.

RocketPort ISA Example RocketModem ISA Example
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11. Click OK to save the device 
configuration. The Main Setup window 
displays:

12. If you have installed more than one 
adapter, you may configure more 
adapters at this time. Click the Add 
button, then repeat Steps 8 through 11 
for each additional adapter installed.

Note: If you are installing more than one 
adapter, install all PCI-bus 
adapters before installing any 
ISA-bus adapters

13. If you have installed a RocketPort 
adapter that is capable of speeds over 
230.4K bps, you can configure the driver 
for high-speed operation at this time. 
Follow these steps:

a. Click the Options tab.
b. Use the Scan Rate droplist to select a 

driver servicing rate. For example, to 
use an Octacable at 460.8K bps, 
select 4. To use a RocketPort Plus at 
921.6K bps, select 2 or 1.

For more information about the 
Options tab and Scan Rate control, 
see Changing or Viewing Driver 
Configuration .

c. Click the Main Setup tab. The above 
window re-displays.

14. Click OK to close the Device Setup window. 

15. Click Yes when the confirmation window displays, asking you to verify that you want to save the 
configuration and exit. The setup process creates and displays the program group:

16. Click OK when this reminder displays.

17. Click Close when the Network Adapters window displays, showing the Comtrol adapter.
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18. Click Yes to shut down and restart the server, or No to 
put it off until a more convenient time.

Note: You must shut down and restart the server 
before your changes take effect. Do not use the 
Comtrol Setup program until you have done so.
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Verifying Installation
After you shut down and restart the server, access the Windows NT Administrative Tools menu and open the 
Event Viewer. 

If the installation was successful, there is an “i” type log entry stating that the driver successfully 
initialized the hardware.

If the installation failed, there is a stop or “!” type event log entry. Double-click on the log entry for more 
information. If the Verbose Event Log option is enabled, additional details may be listed.

If the cause of the problem is not immediately apparent, Troubleshooting on Page 16.

Further Configuration
After you restart the server:

• If you are using a standard RocketPort or RocketPort Plus , review the information under Changing 
or Viewing Port Configuration  and fine-tune the port configuration as needed. Then proceed with installing 
and configuring peripheral devices.

• If you are using a RocketModem, review the information on Modem Reset under Changing or Viewing 
Port Configuration . Then proceed with configuring the modems .

• If you are using a RocketPort 485 or an external RS-485 converter, you must configure both the driver and 
the individual ports for RS-485 operation. See Changing or Viewing Driver Configuration  for information 
on enabling RS-485 at the driver level, then Changing or Viewing Port Configuration  for information on 
enabling RS-485 on selected ports.

Changing or Viewing Driver Configuration
To view or change the driver configuration after installation, follow these steps:

1. Use one of these methods to start the Comtrol Setup program:

a. From the RocketPort/RocketModem program group, double-click on the RocketPort Setup icon.
b. From the Start button menu, select Programs, Comtrol RocketPort/RocketModem, RocketPort Setup.
c. From the desktop, right-click on the Network 

Neighborhood icon and select Properties. The 
Network window displays. Select Adapters, 
Comtrol RocketPort, RocketModem, then click the 
Properties button.

2. Click the Options tab.
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3. Select, de-select, or set the following as 
desired:

a. Verbose Event Log. Check this box to 
cause longer messages to be sent to the 
Windows NT Event Log. This added 
information can be useful when 
debugging communications and 
configuration problems.

b. Scan Rate. Use this droplist to set the 
driver servicing rate. As a general rule 
this is changed only if you are driving 
ports at rates in excess of 230.4 Kbps. For 
example, if you are using a RocketPort 
OctaCable running at 460.8 Kbps, select 
4 ms. If you are running a RocketPort 
Plus at 921.6 Kbps, select 2 ms.

Note: Earlier versions of the Comtrol 
Windows NT driver also required an 
interrupt (IRQ) setting in order to 
achieve high baud rates. The improved 
servicing routine in the 4.x driver no 
longer requires an IRQ.

c. If you are using a RocketPort 485, or if 
you are using a standard RocketPort with 
an external RS-232 to RS-485 converter, 
check the Enable RS-485 box to permit 
RS-485 operation.and you want to use 
RS-485 mode,  If not using RS-485, leave 
this box blank.

Note: This sets the driver  to support RS-485. You must also configure each port  that you plan to use for 
RS-485.

4. When you are done working with the driver configuration options, select the Main Setup tab to return to 
the Main Setup window, or the OK button to save your configuration changes and exit.

Changes to RS-485 status take effect immediately on exit. Changes to the scan rate or event log status 
require that you save your changes and restart the server before your changes take effect.
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Changing or Viewing Adapter Configuration
To view or change adapter (device) configuration after installation, follow these steps:

1. Start the Comtrol Setup program.The Main Setup window displays:

2. In the Configuration window, click on the adapter you want to work with and select the Properties button.

Note: The Summary area displays the basic device configuration, as entered using the Add Device Wizard. 
If this information is not correct, you must remove and re-add the device.

RocketPort ISA Example RocketModem ISA Example
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3. You can view or change the following as desired:

a. Name. The default device name is assigned by the Add Device Wizard. If desired, you can enter a 
more descriptive name.

b. Base I/O Address. (ISA-bus adapters only .) If desired, use the droplist to select a different base I/O 
address.

If this is the first  ISA-bus adapter in the system, the I/O address DIP switch setting on the adapter 
must match the DIP switch illustration shown to the right of the entry field.

If this is the second or subsequent ISA-bus adapter, you may select any available I/O address range. 
The address you select here does not have to match the DIP switches on the adapter.

However, the DIP switches on second and subsequent adapters must be set in correct relation to the 
DIP switch settings used on the first  adapter, as described in the hardware installation instructions.

c. Starting COM Port. Use the droplist to select the COM port number to assign to the first port on the 
adapter. All other port numbers will follow in sequence.

If you have more than one adapter installed, the numbering on subsequent adapters will follow from 
the first adapter. (For example, if the first adapter has COM5 through COM12, the second adapter will 
begin with COM13.)

If desired, you can use this control to set nonsequential starting COM port numbers for each adapter, 
thus leaving gaps in the COM port numbering sequence.

Do not use this control to overlap COM port numbers. If you do so, the overlapping ports will be 
disabled.

4. When you are done, click OK to close the Device Setup window and return to the Main Setup window.

Your changes are not saved until you click OK to save and exit from the Main Setup window. When you do 
so, your changes take effect immediately. No reboot is required.

Changing or Viewing Port Configuration
To view or change individual port configuration, follow these steps:

1. Start the Setup program.

The Main Setup window displays:

2. If necessary, click the [+]  button in front of the adapter name so that the ports on the adapter are 
displayed.

Note: To hide the list of ports, click the [-]  button in front of the adapter name.
Changing or Viewing Port Configuration 13



3. In the Configuration window, click on the port you want to work with. Then click the Properties button.

The Port Properties window displays:  

Note: The tabs and options present in this window depend on the adapter model and driver options 
selected.

4. View or change the port properties as desired. For reference, see the following discussions. When you are 
done, click OK to close the Port Setup window and return to the Main Setup window.

If you have clicked the Clone checkbox, the changes you make are applied to all Comtrol ports controlled 
by this driver.

Your changes are not saved until you save and exit from the Main Setup window. When you do, your 
changes take effect immediately. No reboot is required.

General Port Setup
Override and lock baud rate

This option replaces the Baud Rate Mapping option used in earlier versions of this driver, and lets you lock 
selected ports to specific baud rates. After you do so, no matter what baud rate is selected in a host 
application, the actual  rate used is the rate specified here.

Note: Not all rates are supported by all Comtrol products. See your hardware documentation to determine 
if your adapter supports the desired rate. To use rates above 230.4 Kbps, you must also reset the 
scan rate (page 10).

Time on transmit data on port close

Use this droplist to select the length of time to wait for data to clear the transmit buffer after a host 
application has closed the port.

This is typically used with peripheral devices such as printers, to give the data sufficient time to flush 
through the system.

Map CD to DSR

This option is used in installations where there is no connection to the port’s DSR input. Check this box to 
cause the CD input to appear as DSR to the host application, and to perform hardware handshaking with 
CD rather than DSR. This is ignored if flow control is not enabled via IOCTL_SERIAL_SET_HANDFLOW.

RocketPort ISA Example RocketModem ISA Example
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Map 2 stop bits to 1

If the application you use is hardcoded to use two stop bits and you receive framing errors, check this box 
to map 2 stop bits to 1 bit.

Otherwise, leave this box unchecked.

Wait on physical transmission before completing write

This option forces all write packets to wait until the transmit data has physically completed the 
transmission before returning completion to the host application. The default mode (box not checked) is to 
buffer the data in the transmit hardware buffer, and return completion as soon as the packet is in the 
buffer.

Emulate modem hardware RING signal

Check this box to emulate the ring indicator signal. If this feature is enabled, the driver monitors the data 
stream and outputs a software RI whenever the “ring” AT command is received.

Clone

If this box is not checked, changes apply to the selected port only.

If this box is checked, changes apply to all Comtrol ports in the system. 

RS-485 Tab
This tab displays if RS-485 is enabled in the driver Options (page 10). Use it to enable and configure RS-485 
on specific ports. 

If you want to use RS-485, you must a.) have hardware that supports RS-485, and b.) have RS-485 enabled on 
both the driver Options tab and on the individual port.

Override and lock to RS-485 toggle mode

Check this box to switch the selected port to RS-485 mode.

RS-485 Toggle RTS Low

Check this box to toggle the RTS output signal low during data transmission. If this box is not checked, 
RTS is toggled high (asserted) during data transmission.

Modems Tab
This tab displays if the selected port is a Comtrol modem product.

There is one control: the Reset button. To reset the 
selected modem to its default (power-on) state, click the 
button.

This resets only the modem on the selected COM port, 
on the selected adapter. This option cannot be used to 
reset non-Comtrol modems.

Note: Some Comtrol modems do not support reset. To 
determine whether your modem supports Reset, 
see the readme file.
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Adding an Adapter
To add adapters to an existing installation, follow these steps:

1. Shut down the server, switch off the power, and remove the cover.

2. If installing an ISA-bus adapter, set the I/O address DIP switches as indicated in the hardware 
installation instructions.

3. Install the new adapter in an available slot of the correct bus type.

4. Replace the cover and power up the server.

5. Start Windows NT and log in as the system administrator.

6. Start the Setup program. The Main Setup window displays.

7. Click the Add button.

8. The Add Device Wizard starts. Follow the instructions on-screen to configure the newly installed adapter. 
When the wizard finishes, you are returned to the Main Setup window.

9. Click OK to save and exit from the Setup program.

10. Shut down and restart the server, so that your changes take effect.

Removing an Adapter
To remove an adapter, follow these steps:

1. Start the Setup program. The Main Setup window displays.

2. In the Configuration window, click on the adapter to be removed.

3. Click the Remove button.

To change your mind, click the Cancel button immediately. When you re-enter the Setup program, the 
adapter is restored.

4. To permanently remove the selected adapter, click the OK button to save and exit from the Main Setup 
window.

Troubleshooting
If you are having trouble with an adapter, try the following:

1. Follow the instructions in the Hardware Installation Card  to run the Diagnostic and verify that the 
hardware is working correctly, independently of the driver and operating system.

2. Make sure the adapter is seated firmly in the expansion slot and that the expansion slot screw is in place. 
Also, try moving the adapter to another slot, if one of the correct bus type is available, and rerunning the 
Diagnostic.

Note: If the board fails to pass the Diagnostic, stop now and contact Comtrol Technical Support. All of the 
following steps assume that the board is functional and that the problem is either a configuration or 
connection issue.

3. Verify that you are addressing the port correctly. In many applications, device names above COM9 require 
the prefix \\.\ in order to be recognized. For example, to reference COM20, use \\.\COM20 as the file or 
port name.

4. Verify that you are using the correct types of cables in the correct places and that all cables are connected 
securely at both ends.

5. Verify that you have obtained and installed all Microsoft service packs for your operating system.

6. Verify that you have obtained and installed the latest Comtrol driver for your adapter and operating 
system. Current versions of all Comtrol drivers can be downloaded at no charge from the Comtrol ftp/web 
sites.
Adding an Adapter 16



7. Verify that you are using the correct ports. The RocketPort 8J mounting bracket and 
port numbering scheme are shown in the illustration at right. The port on the “top” edge 
of the card is Port 1, and the port at the “bottom” edge of the card, nearest the bus 
connector, is Port 8.

RocketPort and RocketModem products use a variety of mounting brackets, and in some 
cases unused ports may be blocked with dummy plugs, but in all  cases, the port or modem 
at the “top” edge of the adapter is Port or Modem 1.

8. If you are using ISA-bus adapters, verify that the DIP switches on the adapters are set 
as described in the hardware installation instructions and the base I/O addresses in the 
Device Setup window are set as described under Changing or Viewing Adapter 
Configuration .

9. If you are using a PCI-bus adapter, check the Summary in the Device Setup window to 
verify that the correct bus type was selected during installation.

10. Use the Main Setup Options  to reset the Scan Rate to 10 ms.

11. Remove the driver and reinstall it, using a different I/O address (ISA-bus adapters only).

12. If your RocketModem model supports the reset function, use the Reset function (page 15) to reset the 
modem to its default (power-on) state.

13. Use the Test Terminal program  to troubleshoot communications on a port-by-port basis.

14. Use the Port Monitor program  to check for errors, modem control, and status signals.

15. Use the Peer Tracer program  to trace driver events.

16. If you are still unable to resolve the problem, see the Introduction  for information on contacting Comtrol 
technical support.

Known Issues
In addition to the general tips listed above, we have identified a number of specific issues and conditions that 
affect RocketPort or RocketModem   performance.

• All products

Symptom : The board passes the diagnostics initialization test but fails all serial I/O port tests and cannot 
be initialized.

Solution : Check the computer’s CMOS setup. If “Plug & Play OS” is turned on, turn it off, as neither 
Windows NT nor the diagnostic disk support “plug and play.”

• RocketPort  with External Modems and NT RAS

Symptom : Processor utilization changes to 100-percent and modems stop answering.

Solution : Make sure the modem and/or RocketPort interface cables are not switched, and that there is a 
modem connected to every port that is configured for RAS. If you have multiple types of external modems, 
all with different initialization strings, and connect the wrong modem to the wrong port, or fail to connect 
a modem at all, the server will continue attempting to initialize modems until all system resources have 
been consumed.

• RocketPort 8J and NT RAS

The RocketPort 8J (which has eight RJ11 jacks on the mounting bracket) does not support NT RAS, as it 
lacks the full set of modem control lines. All other RocketPort and RocketModem products, including 
RocketPort 8 and RocketPort Octacable, do support NT RAS.

• RocketPort with 3COM/U.S. Robotics Modems

Symptom : Message displays, “The communication device attached to COM xx is not functioning.”

Solution : Most USR modems come from the factory set to “Load NVRAM defaults.” Reconfigure the modem 
to “Load Factory Defaults,” as NT RAS issues settings from the mdm*.inf  file.

• RocketModem and 3COM/U.S. Robotics V.34 Modems

Symptom : When dialing in from a USR v.34 or v.Everything modem, a “clattering” noise develops on the 
line and the speed negotiation sequence locks up.

Solution : Follow these steps:

a. Open the Control Panel.

1
2
3
4
5
6
7
8

Port
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b. Open the Modems applet.
c. Select a RocketModem and click Properties.
d. Select the Connection tab.
e. Click the Advanced button.
f. In the Extra settings field, enter ATS210=12
g. Click OK to save your changes and exit the Modems applet.

• RocketModem with Lotus Notes

When using RocketModem with Lotus Notes, Notes must be configured for “RING” instead of “RI.”

Device Driver and OS Capabilities and Limitations
This device driver supports the Win32 API. The following tables list known device driver and operating 
system capabilities and limits. This information is not relevant to ordinary users, but is important to software 
developers.

Note: In Windows NT, device names above COM9 require the \\.\ prefix in order to be recognized by the 
system. For example, to reference COM20, use \\.\COM20 as the file name.  

 

Device Control Block Settings Status

BaudRate Variable depending on RocketPort or RocketModem model installed

ByteSize 7 or 8

ErrorChar Supported

EofChar Not supported, supports only binary

EvtChar Supported

fAbortOnError Supported

fBinary Always binary mode

fDtrControl Supported

fDsrSensitivity Not supported

fErrorChar Supported

fInX, fOutX Supported

fNull Supported

fParity Supported

fOutxCtsFlow Supported

fRtsControl RTS_CONTROL_DISABLE, RTS_CONTROL_ENABLE,
RTS_CONTROL_HANDSHAKE, RTS_CONTROL_TOGGLE

fTXContinueOnXoff Supported as always TRUE

Parity EVENPARITY, NOPARITY, or ODDPARITY

StopBits ONESTOPBIT or TWOSTOPBITS

XonChar, XoffChar Supported

Unsupported IOCTL Functionality Status

IOCTL_SERIAL_XOFF_COUNTER Not supported

IOCTL_SERIAL_SET_HANDFLOW
(unsupported options)

SERIAL_DSR_HANDSHAKE, SERIAL_DCD_HANDSHAKE, 
SERIAL_DSR_SENSITIVITY

IOCTL_SERIAL_GET_COMMSTATUS
(unsupported options) fDsrHold, fRlsdHold
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Configuring Modems Overview
After installing the hardware and driver for Windows NT, you can use this discussion to configure modem 
COM ports.

RocketPort adapters can support any asynchronous serial modem for use by any application that uses TAPI. 
For information regarding port pinouts and signals, see the Hardware Installation Card .

Note: There is one exception: the RocketPort 8J, which features eight RJ11 connectors on the mounting 
bracket, does not work with NT RAS, as it lacks the necessary modem control signals. 

All other RocketPort models, including the RocketPort 8 and RocketPort Octacable, do work with NT 
RAS.

RocketModem boards are essentially RocketPort boards with dedicated connections to built-in modems. The 
serial ports are not accessible externally.

Comtrol products are frequently used to provide Dial-Up Networking access with NT RAS (Remote Access 
Service). 

• If RAS is not installed, note that you must install at least one RAS-capable device (for example, modem) 
before installing and configuring RAS.

• If RAS is installed, note that the modem installation process automatically launches RAS Setup after 
modem installation is complete.

Installing Modems
The following instructions were developed using Comtrol modem products. If you are using another brand of 
modem, note that some prompts and screen descriptions may differ from those shown.

Follow these steps:

1. If RocketPort, connect the modems to the desired ports and power up the modem or if RocketModem, install 
the RockeModem adapter using the Hardware Installation documentation.

2. Open the Control Panel window and double-click the 
Modems icon or if you have no other modems installed, 
skip to Step 3. If you have already installed another 
modem, select the Add button.

3. Check the “Don’t detect my modem...” box and click Next.

Note: While Windows NT can automatically detect modems, we advise against using this option as auto-
detect feature may cause some multiprocessor systems to lock up.
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4. Select the appropriate manufacturer and 
model and click OK. If the correct 
manufacturer and model do not appear on the 
list, click Have Disk to install software from a 
manufacturer-supplied installation diskette.

5. Select the port on which you wish to install 
the modem. If you have multiple modems of the same type (for example, four RocketModem adapters), 
you can select more than one port and install all the modems at the same time.
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6. Select Finish. The modem software is installed on the selected ports.

Note: Depending on prior configuration, you may be asked to enter your country of use, area code, the 
number you dial to get an outside line, and whether you have tone or pulse dialing at this time.

7. Click Finish.    
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8. If you need to configure modem properties (maximum 
baud rate, data bits, parity, and so on), click the 
Properties button, make the needed changes, then click 
OK to return to this window.

Note: For help configuring modem properties, see the 
Windows Help system.

9. If you need to configure dialing properties (country, area 
code, calling card number, and so on), click the Dialing 
Properties button, make the needed changes, then click 
OK to return to this window.

10. Click Close.
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Further Modem Configuration
At this point:

• If you are not using RAS, you are now finished. Reboot the server so that your changes take effect and 
resume normal operations.

• If you plan to use RAS but do not have it installed yet, reboot your system, then go to Installing RAS 
Initially .

• If you already have RAS installed and configured, this dialog box displays. 

If you do not want to configure this modem for use with RAS at this time, click No, then reboot and resume 
normal operations.

If you do want to configure this modem for use with RAS, do not reboot. Instead, click Yes, then go directly 
to Adding or Reconfiguring a RAS Device

Installing RAS Initially
After installing the  hardware and driver, and installing and configuring at least one RAS device (for 
example, a modem), use this section to install and configure Remote Access Service (RAS).

If you have not previously installed RAS in your Windows NT server, log into the server with Administrative 
rights and follow these steps:

Note: This example shows how to install and configure RAS for use with modems, but you can use it as a 
guide to setting up other serial devices.

1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhood and 
select Properties. The following screen displays:

2. If Windows NT 4.0 , select the Services tab and click the Add button. 
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If Windows NT 3.51 , select the Add Software button, highlight the Remote Access Service selection, and 
click the OK button. The following screen displays.

3. Click the Add button.

4. Highlight Remote Access Service and click the OK button.

5. Enter the location of the Windows NT files (for example, d:\i386) and press the Continue button. 

The appropriate files are copied onto your hard drive.

The RAS installation process automatically launches the Add RAS Device process. Go to Adding or 
Reconfiguring a RAS Device , Step 5.

Note: If you install or reinstall RAS from your original Windows NT 4.0 distribution media, you must install 
or reinstall the latest Windows NT Service Pack after installing/reinstalling RAS. This is necessary 
because most Service Packs include RAS-related files that are newer than the files on the NT 
distribution media.
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Adding or Reconfiguring a RAS Device
There are several different ways to start this procedure:

• If you have previously installed RAS and configured at least one RAS device, and are now adding or 
reconfiguring RAS devices, begin with Step 1.

• If you have previously installed RAS and were in the process of installing a modem when this process 
started automatically, begin with Step 3.

• If you were in the process of installing RAS when this process started automatically, begin with Step 5.

Follow these steps:

1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhood and 
select Properties.
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2. If Windows NT 4.0, select the Services tab.

If Windows NT 3.51, highlight the Remote Access Service selection and click OK.

3. Highlight Remote Access Service and click the 
Properties button. The Remote Access Setup 
window displays: 

4. To reconfigure an existing RAS port, 
highlight the port/device and click the 
Configure button. Then go to Step 7.

5. To add a new RAS device—for example, if 
you are configuring a new modem—click the 
Add button. The Add RAS Device window 
displays:

6. Use the droplist to select the COM port (modem) that you want to configure and click the OK button.

Note: If no modems appear on this list, you need to install a modem, see Installing Modems .
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7. Highlight the desired COM port (Modem) and click the Configure button. .

8. Select the appropriate radio button, based on the role the modem will perform, and click the OK button..

Note: When configuring multiple simultaneous RAS dial-in ports, configure the ports to “Receive calls 
only” not “Dial out and Receive.” Configuring a port to dial-out requires a separate memory pool for 
each dial-out port, while all ports configured for receive-only share the same memory pool.

If you configure too many ports for dial-out unnecessarily, resources can become an issue. If you 
require dial-out on the RAS server, configure one port to “Dial out and Receive” and all the other 
ports to “Receive calls only.”

The Remote Access Setup window displays again. 
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9. Highlight the COM port (modem) again and click the Network 
button.

10. Select the appropriate dial out protocols, dial in protocols, 
logon security levels, enable multilink (if required) and click 
OK.

Note: Only previously configured protocols are selectable. If 
you want to set up a protocol that is grayed out, you 
must first add it using the Network Protocols tab.

If you selected “Receive calls only” on all ports while 
configuring the port usage, the “Dial out Protocols” area will 
be shaded.

Windows NT 4.0: If you want to use Multilink PPP (bonding), 
make sure that you click the Enable Multilink  checkbox. 

For detailed information about the configuration screens, use 
the Help button or the Windows NT CD-ROM ( Support/books/
server.hlp file to locate information).

Note: The following steps are dependent upon the protocol 
selections made in this screen.

11. If you select NetBEUI on the Network Configuration screen, 
the following window displays. Make the appropriate 
selection for your environment and click OK. 

12. If you select TCP/IP, the following window displays. Make the appropriate selections for your 
environment and press OK.
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13. If you select IPX, the following window displays. Make the appropriate selection for your environment 
and press OK. 

14. Click OK to exit the Network Configuration screen and return to the Remote Access Setup screen.

Note: Choices made during network configuration will effect the entire system.

15. If you want to duplicate the configuration 
you just created on any other COM port 
(modem), highlight the COM port 
number and click Clone. Otherwise, 
repeat Steps 7 through 14  for each COM 
port (modem) you want to set up.

16. After setting up all the COM ports, click 
the Continue button.

17. Click the Close button at the Network/
Services tab to complete the RAS 
installation.

18. Click Yes when asked to reboot the 
computer.

Windows NT RAS installation is 
complete.

19. If necessary, install the latest NT Service Pack or Packs from Microsoft.

Adding Serial Printers
Use this subsection to configure printers for the RocketPort after installing the RocketPort hardware and 
driver.

Follow these steps to configure a serial printer in Windows NT:

1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable unless the printer maker 
specifies otherwise.

2. Open the Printers control panel and double-click on the Add Printer  icon. 
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3. Click the My Computer checkbox, then the Next button.

Note: This differs from Windows NT 3.51. Under NT 3.51, printers on Comtrol ports are network devices.

4. If the desired COM port is on this screen, select it, click on the Next button, and skip to Step 6.

5. If the desired COM port is not on this list, click the Add Port button and follow these steps:

a. A list of printer ports is displayed. Click Local Port.

b. Click New Port.
c. Type in the name of the port.
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Note: Port names above COM9 require the \\.\ prefix. For example, to reference COM12, enter \\.\COM12.
d. Click the OK button. 
e. Click the Close button to return to the Add Printer Wizard.
f. Click the Next button.

6. Select the printer make and model and click the Next button. 

If your printer is not on the make and model lists, but you have a manufacturer-supplied printer diskette, 
click the Have Disk button.

If you have already installed another printer using this driver, you are asked if you want to keep the 
existing driver.

7. To keep the driver: check Keep existing driver, click Next, and go to Step 8.

If you choose Replace existing driver, or if you have not previously installed this driver, you are prompted to 
insert either the Windows NT CD-ROM or the manufacturer’s printer diskette. Do so and click Next.
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8. Select whether you want this printer to be the Windows NT default printer, and click on the Next button.

9. Select whether or not you want to share this printer with other computers on the network. If you select 
Shared, you are asked to indicate the operating systems of all the computers that will be sharing this 
printer. (You may also be required to insert the operating system media so that Windows NT can extract 
the necessary driver files.)

10. Select whether to print a test page and click on the Finish button.

You are now ready to begin using the printer. No reboot is needed.

Changing Printer Port Configuration
If the printer does not successfully print the test page, it may be necessary to change the port baud rate, 
parity, and so on. If the Ports applet does not configure the port properly, you may have to use the mode 
command from a DOS prompt. Also, check the printer for DIP switches or other hardware configuration 
options.

Changing Printer Port Assignment
To change the port assigned to a printer, follow these steps:

1. Open the Printers control panel.

2. Right-click on the icon for the printer you want to change.

3. Select the Properties option from the menu. The Properties window is displayed. 

4. Click the Ports tab.

Note: The Properties window also gives you access to printer test and setup options that can be very 
helpful when debugging a serial printer installation.

5. Check the port you want to switch to. Remember to change your cabling accordingly.

Note: The Configure button on the Ports tab does not recognize Comtrol ports. This is a limitation of 
Windows NT. If you need to reconfigure the port, use the Ports option on the Control Panel.

6. Click on the OK button. Any changes you make take effect immediately. No reboot is needed.
Changing Printer Port Configuration 32



Troubleshooting 
If you are having trouble with a Comtrol device, try the following.

Note: Most customer problems reported to Technical Support  are traced to cabling or network problems.

1. Verify that you are using the correct types of cables in the correct places and that all cables are tightly 
connected.

2. Enable the Verbose Event Log feature under the Setup Options tab  and then reboot the server.

3. Verify that you are addressing the port correctly. In many applications, device names above COM9 require 
the prefix \\.\ in order to be recognized. For example, to reference COM20, use \\.\COM20 as the file or 
port name.

4. Use the Test Terminal  program ( wcom32.exe) to troubleshoot communications on a port-by-port basis.

5. Use the Port Monitor  program ( portmon.exe) to check for errors, modem control, and status signals. In 
addition, it provides you with raw byte input and output counts.

6. Use the Peer Tracer  program ( peer.exe) to trace driver events.

7. Remove and reinstall the driver.

Using Test Terminal
WCOM32 is a terminal program that enables you to open a port, send characters and commands to the port, 
and toggle the control signals.

Note: WCOM32 will not  work on ports used by RAS if Remote Access Service is running  or any other 
application is using the port. If you are using RAS, you must stop the service before starting WCOM32 
to test RAS COM ports. To test ports that are not used by RAS, you do not need to stop RAS.

Follow these steps:

1. To start WCOM32, select Test Terminal from the Comtrol program group. The program window displays: 

2. Select Open Port from the Port menu. A list of possible COM port numbers displays.

3. Select the COM port you want to test. 
If the COM port does not exist or if it 
is currently being used by another 
program, a Create File Error message 
displays. If the COM port is 
available, a terminal window pops 
up:   

Note: Notice the <loop> button in the 
terminal window. If this option is 
activated, it is green and 
uppercase ( ), the COM port 
internal loopback feature is 
activated, and the data is returned 
by the COM port hardware. If this 
option is deactivated, it is gray 
and lowercase ( ), the internal 
loopback is deactivated, and the 
data is sent out the COM port.
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Testing a RocketPort 
1. Place a loopback plug on the COM port you are testing. Make sure all connectors are seated firmly and that 

the loop button is off. 

2. From the Port menu, select Send Test Data. The program sends out a repeating data stream. 

Note: To stop the data stream, select Send Test Data again. 

• If the loopback plug is in place and the port is working correctly, the test data should be echoed back 
to the screen. 

• If the loopback plug is not in place or the port is not working correctly, no data or garbled data is echoed 
back to the screen. 

Note: If no characters appear, try putting the loopback plug on an adjacent port. It may be that you have 
the ports mixed up. 

3. If further testing is required, select Loopback Test from the Port menu. 

If the loopback plug is in place and the port is working correctly, the system should return the message 
“Passed.”

If the loopback plug is not in place or the port is not working correctly, the system will return the message 
“Failed.” 

4. If the port has failed in Step 2 or 3, and the RocketPort is equipped with an external interface box or 
fanout cable, click the loop button to switch the internal loopback feature on. 

5. Repeat Steps 2 and 3. If the port now passes the tests, the fault may lie in the interface box or fanout 
cable. Contact Comtrol technical support for more assistance. 

Testing a RocketModem
The following test may be used to ensure functionality of the RocketModem.

Note: Make sure the loop button is off  for the following tests.

Test 1:

The following steps check to see if the modem responds.

1. Type atz. This should return an OK.

2. Type at&v.  This should display the modem configuration.

Test 2:

The following test calls from the modem to an ordinary telephone.

1. Connect the modem to a phone line.

2. Enter atdtphonenumber. The telephone should ring.

Where phonenumber  is the phone number of an ordinary telephone. 

Test 3:

This example has one modem call another modem.

1. Enter +++ath to hang up.

2. Connect two modems to phone lines, open two Test Terminal sessions, and use one modem to call the 
other. Send typed characters from one modem to the other.

Test 4:

You can call into a host system and use Test Terminal to emulate an ANSI terminal session.
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Modem Control Signals 
The terminal window displays the modem control signals as gray or green lights at the top of the window. The 
first four are inputs: 

The lights are green if they are turned on, or gray if off. The text on the light also changes from uppercase 
(CTS), which is on, to lowercase (cts), which is off.

Note: Ring Indicator (RI) is available on the RocketPort Plus  only.

The next two lights are outputs:  

Note: If you have a loopback plug connected and you click on one of the outputs, the corresponding signal is 
sent to the input and the input lights should toggle accordingly.

You can use RTS and DTR to send flow-control signals to the modem. However, this does not register on 
the input lights.

The rightmost light is the loop indicator:  

If this is on, the COM port internal loopback feature is activated and any information or code entered in the 
terminal window loops back through the COM port circuitry. If this is off, the COM port internal loopback is 
deactivated, and any information or code entered in the terminal window is sent out of the port.

Using Port Monitor
The Port Monitor program ( portmon.exe) offers a summary of all RocketPort  or RocketModem statistics in one 
spreadsheet view. It also enables you to verify operation of all Comtrol ports from a single window. 

The Port Monitor display follows the familiar spreadsheet model: each COM port is a horizontal row, and each 
vertical column displays a variable or value for the respective COM port. For definitions of the abbreviations 
used, see the Port Monitor Variable List .

Port Monitor can also produce statistics and reports that can help you verify the operation of the COM ports 
and connected peripherals. 

Some immediate feedback includes:

• The state of the modem control and status signals

• Open ports

• Raw byte input and output counts obtained from the driver

• Port errors

The available statistics include:

• Instantaneous characters per second (CPS) calculations

• Minute, hour, and day CPS averages and peaks

• Carrier detect (CD) signal runtime and transition count

Reports can be automatically generated on an hourly and/or daily basis, and can cover all ports collectively or 
a separate report for each port. You can also set how often the values are recalculated, fine-tuning 
thoroughness against system efficiency, and automatically run external batch files to perform additional 
processing and analysis.
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Starting Port Monitor
To run Port Monitor, select Port Monitor  from the Comtrol program group. 

The monitor window displays:

Note: To change the appearance of the 
screen, see the following discussion.

Once the monitor window displays, Port 
Monitor is active and collecting data. If any 
cumulative data has been saved from 
previous sessions, it is automatically brought 
in and used.

Port Monitor continues to run and collect 
data until you terminate it, at which point all 
accumulated data is automatically saved for 
use in the next session.

Changing Screen Appearance
While Port Monitor is running, there are a number of commands and controls that change the appearance of 
the screen.

* The Reset command does not clear raw data from the calcs.dat file. It simply resets the selected display fields 
to their null values. For more information regarding calcs.dat see page 37.

Port Monitor Screen Commands 

Desired Change Procedure

Change the monitor window font. Select Font from the Edit  menu.

Change width of a single column. Left-click on the column separator (vertical) line and drag it to the 
desired width.

Change column placement. Left-click in the middle of the column you want to move and drag it 
to the desired location.

Remove a column. Right-click on the column you want to remove and select Remove 
from the pop-up menu.

Clear all fields and reset them to null 
values.

Right-click on the upper left cell in the table and select Reset from 
the pop-up menu.*

Clear any single field except the upper 
left cell.

Right-click on the field to be cleared and select Reset from the pop-
up menu.*

Add a column.

Right-click on the column now occupying the desired location and 
select Add from the pop-up menu.
You are prompted to name the variable you want to display, as well 
as other information. (See Column Setup , below.) 
After you click OK, the column is inserted in the selected location 
and the existing column is moved to the right.

Change other properties of a column. Right-click on the column and select Properties from the pop-up 
menu. (See Column Setup , below.)
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Column Setup
When you select Add or Properties from the column pop-up menu, 
the Column Setup window displays: 

• Use the Input  droplist to select the variable displayed in the 
column.

• Use the Type droplist to select the way in which the value 
displays: either as an integer, as an on/off state, as an integer 
with a kilo, mega, or giga suffix, or as an hh:mm:ss time stamp. 
This defaults to the appropriate type for the selected Input 
variable.

• Use the Name variable to change the column heading name.

• Use the Width  variable to specify the column width in 
characters.

• Use Color0 to set the column character color when the value is 
zero.

• Use Color1 to set the column character color when the value is 
not zero.

• When done, click OK to save your changes and return to Port Monitor.

Report Configuration
To configure reports, select Config from the Edit 
menu. 

The Single report options cover all ports and are 
overwritten each time the reports are generated. 
The Multiple  report options generate a separate 
report for each port, and each report file is 
appended each time the report is generated.

For Hour  reports, use the Single and Multiple 
droplists to select whether you are generating 
single or multiple reports, or both. For each report 
type, select from the following types of data to 
include:

• None: no report is generated.

• Hour Data: only variables with “Hour” in the 
name are included.

• All Data: all variables are included.

• View Data: only variables that appear on-
screen are included.

The External Program field is used to enter a command line to run another program after the hourly reports 
have been generated. For example, you can use this to run a batch file that performs custom report 
processing. The Test button causes the command line to be executed immediately.

For Day reports, the single and multiple droplists behave the same, but your choices are:

• None: no report is generated.

• Day Data: only variables with the words “Day” or “Raw” in the names are included.

• All Data: all variables are included.

• View Data: only the variables that appear in the Port Monitor window are included.

Likewise, the External Program field is used to enter a command line to be executed after the daily reports 
have been generated.

The Update Time option allows you to set the rate at which the port information is obtained and the 
calculations performed. There is a trade-off between Port Monitor efficiency and response time. If you are 
using Port Monitor to view the port activity on the screen, you may want to set the update time to 1 or 2 
seconds, so that the screen is updated frequently. If you are concerned about the monitor program using CPU 
resources, set this to a higher value, (6 to 20 seconds) in order to decrease the time required by the program to 
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perform the calculations and update the screen.

If Port Monitor is left active to generate reports, minimizing or reducing the display area of the program will 
help reduce the CPU overhead of updating the screen.

Port Monitor Files
Port Monitor creates and uses the following files:

• portmon.vew

• calcs.dat

The default column layout is saved in portmon.vew. If you have been experimenting with the appearance of the 
monitor screen, you can use the File menu Save option to save your customized layout in another .vew file. You 
can retrieve this file later by using the File menu Open option, or you can use the Edit menu View Default 
option to retrieve portmon.vew and restore the default view.

All Port Monitor calculations are saved at program exit and on the hour in a binary file named calcs.dat. This 
enables you to halt Port Monitor execution without losing accumulated data.

Port Monitor also creates a \REPORTS directory. All hourly and daily reports are saved in this directory, 
under the following names:

• hall.txt  — hourly single report

• dall.txt  — daily single report

• hcomx.txt — hourly multiple reports, where x is the port number

• dcomx.txt — daily multiple reports, where x is the port number

Caution:  Since multiple reports append new data each time they are written, the multiple report files grow in 
size. It is up to you to delete them periodically.

Some safeguards are built into the program to avoid filling up a hard disk drive due to growing report files. 
The monitoring program stops writing additional data to the multiple reports if they reach a size of 2 MB. 
Also, the program will not write out data files to the disk drive if the spare room on the drive is less than 2 
MB in size.

To view or edit an hourly or daily report, use the Edit Report option on the File menu, or use a system tool 
such as NOTEPAD.

For more information, see the Port Monitor Help file.

Port Monitor Variables 
The following table lists Port Monitor variables. 

Port Monitor Variable List 

Variable Description

Open Open status, on if open, off if closed.

Cts Input CTS pin status.

Dsr Input DSR pin status.

Cd Input CD (carrier detect) pin status.

Rts Output RTS pin status.

Dtr Output DTR pin status.

TxTotal Total bytes transmitted.

RxTotal Total bytes received.

TxCPSInst Instantaneous average of transmit characters per second.

RxCPSInst Instantaneous average of receive characters per second.

Errors Total hardware receive errors (parity, framing, and overruns.)

TxMinCPS Last minute average of transmit characters per second.

RxMinCPS Last minute average of receive characters per second.
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TxCPSMinAvMax Peak TxCPSInst for the last minute.

RxCPSMinAvMax Peak RxCPSInst for the last minute.

TxCPSHourAvMax Peak TxMinCPS for the last hour.

RxCPSHourAvMax Peak RxMinCPS for the last hour.

TxCPSDayAvMax Peak TxMinCPS for the last day.

RxCPSDayAvMax Peak RxMinCPS for the last day.

TxTotalRaw Total number of transmit bytes raw data from the driver.

RxTotalRaw Total number of receive bytes raw data from the driver.

TxMinCnt Count of transmit bytes sent in last minute.

TxHourCnt Transmit bytes count sent in the last hour.

TxDayCnt Transmit bytes count sent in the last day.

RxMinCnt Receive bytes count sent in the last minute.

RxHourCnt Receive bytes count sent in the last hour.

RxDayCnt Receive bytes count sent in the last day.

TxMinCntWrk Transmit bytes count sent in this minute.

TxHourCntWrk Transmit bytes count sent in this hour.

TxDayCntWrk Transmit bytes count sent in this day.

RxMinCntWrk Receive bytes count sent in this minute.

RxHourCntWrk Receive bytes count sent in this hour.

RxDayCntWrk Receive bytes count sent in this day.

TxCPSMinAvMaxWrk Peak TxCPSInst for the current minute.

TxCPSHourAvMaxWrk Peak TxMinCPS for the current hour.

TxCPSDayAvMaxWrk Peak TxHourCPS for the current day.

RxCPSMinAvMaxWrk Peak RxCPSInst for the current minute.

RxCPSHourAvMaxWrk Peak RxMinCPS for the current hour.

RxCPSDayAvMaxWrk Peak RxHourCPS for the current day.

CDRuns Carrier detect turn-on count.

CDDayRuns Carrier detect turn-on count in the last day.

CDDayRunsWrk Carrier detect turn-on count in the current day.

CDRunTime Time in seconds carrier detect has been on.

CDHourRunTime Time in seconds carrier detect has been on in the last hour.

CDDayRunTime Time in seconds carrier detect has been on in the last day.

CDHourRunTimeWrk Time in seconds carrier detect has been on this hour.

CDDayRunTimeWrk Time in seconds carrier detect has been on this day.

StatusFlags Bit flags, Open, CTS, DSR, CD, RTS, DTR

TxPkts Raw count of total transmit packets sent.

RxPkts Raw count of total receive packets sent.

OverrunErrors Total count of receive overrun errors.

Port Monitor Variable List (Continued)

Variable Description
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Using Peer Tracer
The Peer Tracer program ( peer.exe) is specifically designed to view the internal operations of the driver for the 
purpose of troubleshooting communications on Windows NT systems. Peer enables you to see:

• Receive and transmit data

• Internal driver event traces

• Advanced configuration and status information

Like Test Terminal, Peer acts as a simple terminal session, and is used to send and receive text information to 
and from the driver. To use Peer, you type in commands, and status and information are sent back.

Unlike Test Terminal, Peer enables you to keep a continuous log of the commands sent and the results 
received in a file named peer.log. 

Comtrol Technical Support may ask you to run Peer in order to help diagnose reported problems.

Starting Peer
Peer Tracer does not appear in the Comtrol 
program group. To use it, you must open Windows 
Explorer , access the C:\WINNT\system32\rocket 
directory, and double-click on peer.exe. The Peer 
Tracer window displays: 

Log Functions
All logging functions are found under the File 
menu. To start keeping a log, select Log to Disk from 
the File menu. The other options on this menu are 
View Disk Log, Clear Disk Log, Clear Screen, and Exit.

Using Peer
To use peer, simply type in commands at the : prompt. (It may be necessary to press Enter to make the : 
prompt appear.) For example, to examine COM5, type:

PORT COM5 <Enter>

To gather some information about the port, type:

STAT <Enter>

This should return details about the port.

To turn on monitoring of any calls into driver (events), type:

MON EV <Enter>

To send strings and commands to attached peripherals—for example, to send “ATH0” to a modem—type:

SEND ATH0 <Enter>

A return and linefeed are always appended to each string sent.

Other Commands
Enter commands at the : prompt and follow each command with Enter.

FramingErrors Total count of receive framing errors.

ParityErrors Total count of receive parity errors.

OverrunErrorsRaw Total count of receive overrun errors, from the driver.

FramingErrorsRaw Total count of receive framing errors, from the driver.

ParityErrorsRaw Total count of receive parity errors, from the driver.

Port Monitor Variable List (Continued)

Variable Description
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Keep in mind that all commands are processed in the driver, and that Peer simply acts as a conduit for this 
information. 

For more information, see the Peer.hlp help file.

Technical Support
Comtrol has a staff of support technicians available to help you. 

You should review Troubleshooting  and run through the diagnostics before calling Technical Support. 

Note: The web site has On-Line Technical Support available.

In addition, please have the following information available.

Comtrol Headquarters Comtrol Europe
Internet URL: www.comtrol.com www.comtrol.co.uk
email: support@comtrol.com support@comtrol.co.uk
Phone: (763) 494-4100 +44 (0) 1 869-323-220

FAX: (763) 494-4199 +44 (0) 1 869-323-211

FTP site: ftp.comtrol.com
FAQ On-line Help: www.comtrol.com/coperate.htm

Disclaimer and Copyrights
Copyright © 1994-2000. Comtrol Corporation. 
All Rights Reserved.
Second Edition, November 7, 2000
Comtrol Corporation makes no representations or warranties with regard to the contents of this guide or to 
the suitability of the Comtrol products for any particular purpose. Specifications subject to change without 
notice. Some software or features may not be available at the time of publication. Contact your reseller for 
current product information.

Trademarks

Peer Tracer Commands

Command Effect

MON TX Monitor data being transmitted through the selected port.

MON RX Monitor data being received through the selected port.

M Turn off all monitoring.

? Display Peer Tracer command summary.

PORT COMxx Change port being examined to COM xx.

Support Call Information

Item Information

Hardware type 

Hardware serial number*

Operating system type

Driver part number and revision level

Server computer make, model, and speed

Devices connected to the adapter
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	How to Use this Document
	Driver Requirements
	Installation Prerequisites
	1. You must have at least one RocketPort or RocketModem adapter installed before installing this ...
	2. If you are using Windows NT 3.51 or an early version of Windows NT 4.0 with no service packs a...
	3. If you are installing the RocketPortModem in a server without an existing network adapter (NIC...
	4. If you are using this driver under Windows NT 3.51, or if you are using the modem.inf file und...
	5. Finally, if you are upgrading from an earlier version of the RocketPortModem device driver, yo...

	Removing an Existing Driver
	1. Open the Control Panel and start the Network applet.
	2. If using Windows NT 4.0, select the Adapters tab. If using Windows NT 3.51, skip to the next s...
	3. Highlight Comtrol RocketPort,RocketModem.
	4. Click the Remove button. You are asked to verify the deletion.
	5. Click Yes. The selected item is deleted.
	6. Click Close. Several windows are displayed as the system updates its configuration:
	7. Click Yes to shut down and restart the server, so that your changes take effect.
	8. After removing the existing driver, use the Installing a New Driver discussion.

	Special Instructions
	Installing the New Driver
	Driver Installation
	1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhoo...
	2. If Windows NT 4.0, select the Adapters tab.
	3. Windows NT 4.0 only: Click the Add button. The list of supported network adapters displays:
	4. If Windows NT 4.0, click the Have Disk button.
	5. If installing the driver from a diskette, insert the diskette.
	6. Enter the drive and directory path to the installation files and click the OK button.
	7. Click the OK button with Comtrol RocketPort/RocketModem highlighted.
	8. Click Next when the Add Device Wizard appears and follow the on-screen instructions to configu...
	a. Bus Type. Select ISA or PCI and click Next.
	b. Model. Use the droplist to select the Comtrol product you have installed, and click Next.
	c. Number of Ports. Use the droplist to select the number of ports on the product you have instal...
	d. Base I/O Address. (ISA-bus products only.) Use the droplist to select the I/O address you set ...
	e. Country. (Comtrol modem products only.) Use the droplist to select the country or region where...

	9. When you have finished entering adapter configuration information, click the Finish button. Th...
	10. Review the information shown. If desired, you can enter a more descriptive name for the adapt...
	11. Click OK to save the device configuration. The Main Setup window displays:
	12. If you have installed more than one adapter, you may configure more adapters at this time. Cl...
	13. If you have installed a RocketPort adapter that is capable of speeds over 230.4K bps, you can...
	a. Click the Options tab.
	b. Use the Scan Rate droplist to select a driver servicing rate. For example, to use an Octacable...
	c. Click the Main Setup tab. The above window re-displays.

	14. Click OK to close the Device Setup window.
	15. Click Yes when the confirmation window displays, asking you to verify that you want to save t...
	16. Click OK when this reminder displays.
	17. Click Close when the Network Adapters window displays, showing the Comtrol adapter.
	18. Click Yes to shut down and restart the server, or No to put it off until a more convenient time.

	Verifying Installation
	Further Configuration
	Changing or Viewing Driver Configuration
	1. Use one of these methods to start the Comtrol Setup program:
	a. From the RocketPort/RocketModem program group, double-click on the RocketPort Setup icon.
	b. From the Start button menu, select Programs, Comtrol RocketPort/RocketModem, RocketPort Setup.
	c. From the desktop, right-click on the Network Neighborhood icon and select Properties. The Netw...

	2. Click the Options tab.
	3. Select, de-select, or set the following as desired:
	a. Verbose Event Log. Check this box to cause longer messages to be sent to the Windows NT Event ...
	b. Scan Rate. Use this droplist to set the driver servicing rate. As a general rule this is chang...
	c. If you are using a RocketPort 485, or if you are using a standard RocketPort with an external ...

	4. When you are done working with the driver configuration options, select the Main Setup tab to ...

	Changing or Viewing Adapter Configuration
	1. Start the Comtrol Setup program.The Main Setup window displays:
	2. In the Configuration window, click on the adapter you want to work with and select the Propert...
	3. You can view or change the following as desired:
	a. Name. The default device name is assigned by the Add Device Wizard. If desired, you can enter ...
	b. Base I/O Address. (ISA-bus adapters only.) If desired, use the droplist to select a different ...
	c. Starting COM Port. Use the droplist to select the COM port number to assign to the first port ...

	4. When you are done, click OK to close the Device Setup window and return to the Main Setup window.

	Changing or Viewing Port Configuration
	1. Start the Setup program.
	2. If necessary, click the [+] button in front of the adapter name so that the ports on the adapt...
	3. In the Configuration window, click on the port you want to work with. Then click the Propertie...
	4. View or change the port properties as desired. For reference, see the following discussions. W...

	General Port Setup
	RS-485 Tab
	Modems Tab
	Adding an Adapter
	1. Shut down the server, switch off the power, and remove the cover.
	2. If installing an ISA-bus adapter, set the I/O address DIP switches as indicated in the hardwar...
	3. Install the new adapter in an available slot of the correct bus type.
	4. Replace the cover and power up the server.
	5. Start Windows NT and log in as the system administrator.
	6. Start the Setup program. The Main Setup window displays.
	7. Click the Add button.
	8. The Add Device Wizard starts. Follow the instructions on-screen to configure the newly install...
	9. Click OK to save and exit from the Setup program.
	10. Shut down and restart the server, so that your changes take effect.

	Removing an Adapter
	1. Start the Setup program. The Main Setup window displays.
	2. In the Configuration window, click on the adapter to be removed.
	3. Click the Remove button.
	4. To permanently remove the selected adapter, click the OK button to save and exit from the Main...

	Troubleshooting
	1. Follow the instructions in the Hardware Installation Card to run the Diagnostic and verify tha...
	2. Make sure the adapter is seated firmly in the expansion slot and that the expansion slot screw...
	3. Verify that you are addressing the port correctly. In many applications, device names above CO...
	4. Verify that you are using the correct types of cables in the correct places and that all cable...
	5. Verify that you have obtained and installed all Microsoft service packs for your operating sys...
	6. Verify that you have obtained and installed the latest Comtrol driver for your adapter and ope...
	7. Verify that you are using the correct ports. The RocketPort 8J mounting bracket and port numbe...
	8. If you are using ISA-bus adapters, verify that the DIP switches on the adapters are set as des...
	9. If you are using a PCI-bus adapter, check the Summary in the Device Setup window to verify tha...
	10. Use the Main Setup Options to reset the Scan Rate to 10 ms.
	11. Remove the driver and reinstall it, using a different I/O address (ISA-bus adapters only).
	12. If your RocketModem model supports the reset function, use the Reset function (page�15) to re...
	13. Use the Test Terminal program to troubleshoot communications on a port-by-port basis.
	14. Use the Port Monitor program to check for errors, modem control, and status signals.
	15. Use the Peer Tracer program to trace driver events.
	16. If you are still unable to resolve the problem, see the Introduction for information on conta...

	Known Issues
	a. Open the Control Panel.
	b. Open the Modems applet.
	c. Select a RocketModem and click Properties.
	d. Select the Connection tab.
	e. Click the Advanced button.
	f. In the Extra settings field, enter ATS210=12
	g. Click OK to save your changes and exit the Modems applet.

	Device Driver and OS Capabilities and Limitations
	Configuring Modems Overview
	Installing Modems
	1. If RocketPort, connect the modems to the desired ports and power up the modem or if RocketMode...
	2. Open the Control Panel window and double-click the Modems icon or if you have no other modems ...
	3. Check the “Don’t detect my modem...” box and click Next.
	4. Select the appropriate manufacturer and model and click OK. If the correct manufacturer and mo...
	5. Select the port on which you wish to install the modem. If you have multiple modems of the sam...
	6. Select Finish. The modem software is installed on the selected ports.
	7. Click Finish.
	8. If you need to configure modem properties (maximum baud rate, data bits, parity, and so on), c...
	9. If you need to configure dialing properties (country, area code, calling card number, and so o...
	10. Click Close.

	Further Modem Configuration
	Installing RAS Initially
	1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhoo...
	2. If Windows NT 4.0, select the Services tab and click the Add button.
	3. Click the Add button.
	4. Highlight Remote Access Service and click the OK button.
	5. Enter the location of the Windows NT files (for example, d:\i386) and press the Continue button.

	Adding or Reconfiguring a RAS Device
	1. Open the Control Panel and start the Network applet, or right-click on the Network Neighborhoo...
	2. If Windows NT 4.0, select the Services tab.
	3. Highlight Remote Access Service and click the Properties button. The Remote Access Setup windo...
	4. To reconfigure an existing RAS port, highlight the port/device and click the Configure button....
	5. To add a new RAS device—for example, if you are configuring a new modem—click the Add button. ...
	6. Use the droplist to select the COM port (modem) that you want to configure and click the OK bu...
	7. Highlight the desired COM port (Modem) and click the Configure button. .
	8. Select the appropriate radio button, based on the role the modem will perform, and click the O...
	9. Highlight the COM port (modem) again and click the Network button.
	10. Select the appropriate dial out protocols, dial in protocols, logon security levels, enable m...
	11. If you select NetBEUI on the Network Configuration screen, the following window displays. Mak...
	12. If you select TCP/IP, the following window displays. Make the appropriate selections for your...
	13. If you select IPX, the following window displays. Make the appropriate selection for your env...
	14. Click OK to exit the Network Configuration screen and return to the Remote Access Setup screen.
	15. If you want to duplicate the configuration you just created on any other COM port (modem), hi...
	16. After setting up all the COM ports, click the Continue button.
	17. Click the Close button at the Network/ Services tab to complete the RAS installation.
	18. Click Yes when asked to reboot the computer.
	19. If necessary, install the latest NT Service Pack or Packs from Microsoft.

	Adding Serial Printers
	1. Connect the printer to the desired port. Use a DTE-to-DTE null modem cable unless the printer ...
	2. Open the Printers control panel and double-click on the Add Printer icon.
	3. Click the My Computer checkbox, then the Next button.
	4. If the desired COM port is on this screen, select it, click on the Next button, and skip to St...
	5. If the desired COM port is not on this list, click the Add Port button and follow these steps:
	a. A list of printer ports is displayed. Click Local Port.
	b. Click New Port.
	c. Type in the name of the port.
	d. Click the OK button.
	e. Click the Close button to return to the Add Printer Wizard.
	f. Click the Next button.

	6. Select the printer make and model and click the Next button.
	7. To keep the driver: check Keep existing driver, click Next, and go to Step 8.
	8. Select whether you want this printer to be the Windows NT default printer, and click on the Ne...
	9. Select whether or not you want to share this printer with other computers on the network. If y...
	10. Select whether to print a test page and click on the Finish button.

	Changing Printer Port Configuration
	Changing Printer Port Assignment
	1. Open the Printers control panel.
	2. Right-click on the icon for the printer you want to change.
	3. Select the Properties option from the menu. The Properties window is displayed.
	4. Click the Ports tab.
	5. Check the port you want to switch to. Remember to change your cabling accordingly.
	6. Click on the OK button. Any changes you make take effect immediately. No reboot is needed.

	Troubleshooting
	1. Verify that you are using the correct types of cables in the correct places and that all cable...
	2. Enable the Verbose Event Log feature under the Setup Options tab and then reboot the server.
	3. Verify that you are addressing the port correctly. In many applications, device names above CO...
	4. Use the Test Terminal program (wcom32.exe) to troubleshoot communications on a port-by-port ba...
	5. Use the Port Monitor program (portmon.exe) to check for errors, modem control, and status sign...
	6. Use the Peer Tracer program (peer.exe) to trace driver events.
	7. Use the Device Advisor to help identify the problem.
	8. Remove and reinstall the driver.

	Using Test Terminal
	1. To start WCOM32, select Test Terminal from the Comtrol program group. The program window displ...
	2. Select Open Port from the Port menu. A list of possible COM port numbers displays.
	3. Select the COM port you want to test. If the COM port does not exist or if it is currently bei...

	Testing a RocketPort
	1. Place a loopback plug on the COM port you are testing. Make sure all connectors are seated fir...
	2. From the Port menu, select Send Test Data. The program sends out a repeating data stream.
	3. If further testing is required, select Loopback Test from the Port menu.
	4. If the port has failed in Step 2 or 3, and the RocketPort is equipped with an external interfa...
	5. Repeat Steps 2 and 3. If the port now passes the tests, the fault may lie in the interface box...

	Testing a RocketModem
	1. Type atz. This should return an OK.
	2. Type at&v. This should display the modem configuration.
	1. Connect the modem to a phone line.
	2. Enter atdtphonenumber. The telephone should ring.
	1. Enter +++ath to hang up.
	2. Connect two modems to phone lines, open two Test Terminal sessions, and use one modem to call ...
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